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Introduction

What this program does

Trishear 4.5is a program designed for forward and inverse
modeling of fault-related folds using trishear kinematics for the
deformation at the tipline and fault-bend folding over trailing ramps.
In this program, the user can produce complex forward models of
composite trishear—fault-bend fold structures and can retrodeform
real cross sections of simple trishear structures, using an inverse
grid search procedure for extracting the best fit trishear parameters.
Both thrust and normal faults can be modeled. The user has great
flexibility in designing a model. Some of the principal features of
the program are:

1.

Beds and faults can be entered with the mouse or they
can be specified precisely viadiaog boxes.

A model can have up to 20 bed tops. Beds can be added
to amodel at any time (e.g., to simulate growth strata).
Individual beds can have up to 1000 vertices.

A single fault can have up to 100 vertices (i.e., “ramps’)
and a single section can have up to six faults. Back-limb
fold kinematics can be modeled either by parallel kink
folds or by arbitrarily-inclined smple shear.

The user can change the trishear parameters, ramp angles,
or scale of the model at any time.

The program maintains a complete record of the changes
that have been made to a model. The strain can be
calculated at any time and particle paths can be plotted.

Cross-sectional area and line length can be measured at
any time and the section can be rotated globally about
any user-defined axis.

A section can be transferred to other programs via the
clipboard or saved to disk (PICT format for Macintosh
version, BMP format for Windows version), or it can be
exported at higher resolution as a DXF file for import
into graphics programs.

What it cannot do

Trishear 4.5isreally aprogram to study individual structures
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or small groups of structures. Although it can help you to balance
Ccross sections it is not a general cross section balancing program.
For that, you need one of the readily available, if expensive, com-
mercial packages from different vendors.

Further reading

The purpose of this manual is to instruct the user in the use
of this program, not to explain the trishear method, fault-bend folding,
etc. The original concept of trishear was published by Erdlev (1991).
The algorithms used in Trishear 4.5 are described in Allmendinger
(1998) and Zehnder & Allmendinger (2000); earlier versions of the
program used the velocity description of Hardy & Ford (1997).
The basic fault-bend fold theory follows Suppe (1983) and the
arbitrarily-inclined simple shear folding uses the constant heave
method which has been described by a variety of authors. Some
additional references of pertinence to the topic of fault-related folding
are: Suppe & Medwedeff (1990), Suppe et al. (1992), Hardy &
Poblet (1995), Waltham & Hardy (1995), and Medwedeff & Suppe
(1997). Many other references are also available on this topic.

Conventions in This Manual

Information in this manual which is specific to the M acintosh
version of the program is shown in red; that which applies to the
Windowsversion of trishear is shown in blue.

General Layout of Program

Geologic Elements

Before going into the organization of program features such
as menus and windows, a few words about the types of objects to
be manipulated are in order. Trishear 4.5 draws two-dimensional
geologic cross-sections of beds that are cut or folded by faults. The
Fundamental parameters needed to define afault are its tip line
position (which changes with time), ramp angles, slip, propagation-
to-dip ratio (P/S), and trishear angle. Bed tops are defined graph-
ically as a polygons which have up to 1000 vertices. There are two
distinct types of beds:

© Richard W. Allmendinger 1998 — 2000
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1. Forward model beds—these are defined completely with-
in the program and are the only ones which are changed
(i.e., folded or truncated) by the faulting process. You
can add more beds to a forward model after the initial
model has been set up; these are referred to as growth
strata but could equally well be dikes or sills intruded
during deformation. Forward models always have at |east
one fault associated with them.

2. Digitized beds—these are polygons which are imported
into the program from a specially formatted file that
you have generated elsewhere, for example in your graph-
ics program and/or with my utility program DigBeds.
Digitized beds can be moved around the screen and
re-scaled, but they are not otherwise deformed by the
program. Digitized beds do not have to have a fault
associated with them.

Why this distinction between the two bed types? This question
is best answered by looking briefly at therestoration process. Trishear
4.5 dlows you to retrodeform real geologic sections that you have
digitized and the program can find the best fitting trishear parameters
to do so. Let’s say where are talking about a thrust related fold, as
in the example starting on page 16. To do so, one first imports a
digitized bed. While you set the parameters for the restoration,
Trishear 4.5 automatically converts the digitized beds to a forward
model, then the forward model is restored by producing normal
(i.e., extensional) displacement on the thrust fault. But the original
digitized beds remain in the program’s memory in their original
state so that you can compare them to the restoration. If you don’t
like the restoration, you can redo it with new parameters without
importing the data again. You may also want to do a forward
model from scratch to try to compare to a deformed section that
you have digitized and imported. Finally, if you want to do a
forward model with a bed geometry that is more complicated than
can be produced with the New Model dialog boxes (e.g., beds with
initial curving geometry, channels, pinch-outs or pre-existing struc-
tures), you can import these as digitized beds and then convert
them to aforward model, ready to be deformed.

Trishear 4.5 can also import Windows BMP files or Macin-
tosh PICT files to show scanned geologic cross sections, seismic
data, etc. These scanned data act as a “backdrop” to the model in
the program. The scans can be moved and scaled but cannot be
edited in any way.

© Richard W. Allmendinger 1998 — 2000
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The final geologic elements are strain markers and particle
paths. The strain markers areinitialy circular arrays of points which
are deformed along with your beds during fault motion. You can
extract various types of information from the strain markersincluding
principal axes and lines of no finite elongation (LNFE) which may
be used as proxies for shear plane orientation. When you ask Trishear
4.5 to plot principal axes, lines of no finite elongation, or to shade
ellipses by strain magnitude, the program does a least squares best
fit of an ellipse to the array of points which initially defined a
circle. If the strain is too heterogeneous within the region defined
by the ellipse, or in the rare cases where Trishear 4.5 does not
preserve area correctly, the program will not plot the lines, shade
the polygon, etc. even though it will still plot the “ellipse”. Particle
paths are the traces of positions occupied by a single particle during
the deformation.

Graphic/Interface Elements

Trishear 4.5 has six main menus which are organized ac-
cording to the types of tasks that you want the program to carry
out. Like most programs, it has aFile Menu on the left hand side
of the menu bar which handles the saving and reading of the program
output/input as well as printing and quitting or exiting the program.
Also reasonably standard is the Edit Menu where you undo, copy,
and set the preferences for the program. The M odel Menu will be
one of your main work horses: here you tell the program to run,
modify, add faults, or add beds to forward models. Here too, you
get information about forward models such as length, area, etc.
The Restore Menu allows you to import digitized beds and to
specify the parameters necessary for retrodeforming the beds. In
the Plot Menu, you tell Trishear 4.5 what elements you want it to
draw on the screen and with what colors. Severa functions related
to digitized beds also reside in a submenu of the Plot Menu or in
the Scan/Digitize Menu. Finally, the Window M enu determines
which of Trishear’s two main windows is showing on top. It also
allows you to scale the graphics and drag them around on the
screen.

Trishear 4.5 has two main windows: All drawing occursin
the Cross Section Window. In addition to showing the cross section,
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the user can interact with this window via the mouse. You can
click the (right) mouse button in the window to get the position of
apoint or click and drag to measure the length and angle of aline.
The Windows version of the Cross Section Window has scroll bars
to allow you to see all parts of your cross section. In the Macintosh
version, you give a menu command and click and drag the contents
around to see the part that you want. Both versions of the program
show the same information. The History Window maintains a text
record of all of the changes that you make to a model. Information
from this window can be copied to the operating system clipboard
or saved as a text file. Both versions of the program use a large
number of dialog boxes to get input from you.

The Macintosh version of the program has four types of
cursors which clue you into the type of interaction that the program
expects. The arrow cursor is the standard. A cross cursor appears
when you are to click or click and drag in the window to measure
or draw something. A hand cursor appears when you are to drag
the contents of the Cross Section Window, or drag the digitized
beds around in the window. Finally, a watch cursor tells you that a
time-consuming operation is occurring. The Windows version of
Trishear 4.5 uses only an arrow cursor.

A Quick Tutorial

The bulk of this manual consists of a reference section
organized by menu command. To give you a quick overview of the
capabilities of the program, we provide some brief examples to
follow here. Each example assumes that you are starting the program
from scratch and have dismissed the “ About” dialogs.

Simple forward model

The most basic trishear structure is a simple monocline
with no changes in ramp angle, etc. This example will be a bit
more complicated in order to show off some of the inherent flexibility
of the program:

1. Choose New from the File Menu. Click on the Preferences
button and you will get the Preferences Dialog superim-
posed on top of the New Dialog. Check the box labeled
“Pick beds and fault with mouse” and make sure that

© Richard W. Allmendinger 1998 — 2000
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“Calculate strain” is checked (it should be, by default).
Click Okay.

In the Macintosh version, anew dialog will automatically

' appear; in the Windows version you will have to click

the Okay button in the New dialog first. The new dialog
is called “Pick new model with mouse”. Make sure that
5 beds are specified to be entered. Check “ramp up
from decollement” and click the Okay button.

Follow the on screen instructions for entering the beds

" and the faullt. Space the beds tops about 30 units apart,

starting at about 0 and ending about 120. Y ou can enter
aflat bed by just clicking the (left) mouse button or a
dipping bed can be entered by clicking and dragging.
The fault is specified by clicking on the initial tipline
position—say, about (300, 0) for this example—and drag-
ging up to the right to define a positive ramp angle.
Drag a ramp angle of about 30° and a trishear angle of
about 50°. The Macintosh version shows the coordinates
of the mouse at the cursor; the Windows version shows
the coordinates at the bottom of the screen. Note that
Trishear’s screen coordinate system is positive up and
positive to the right. A positive dip isinclined down to
the left'. After you are finished, the initial section with
circles along the beds will be drawn to the screen. You
can turn off the drawing of the circles/ellipses using the
“Show Ellipses’ command under the Plot Menu. The
green line shows the position of the trailing active kink
axis related to the footwall fault bend. Note that hanging
wall (fixed) kink axes are not drawn.

. Choose “Run” from the Model Menu. The section pro-

ceeds to deform itself in increments as you watch. If
you wish to stop a model before it reaches the specified
amount of displacement, just click the (left) mouse button.
Depending on the speed of your computer you may
have to hold the button down for a few moments. Let
the model run to itsfinal dip.

Now choose “Modify” from the Model Menu. Enter a
ramp angle of about 55° and click the Okay button.

Choose “Run” again from the Model Menu... Oops,
nothing happens! That’s because we' ve aready reached
the total dip initially specified. Y ou now have two choic-

The New Model with Mouse
dialog box

-

ick a New Model with Mouse = 5

[P

Number of Beds:

I

P N e
Inmdial gL (A) coora.

Fault

Propagation/Slip:
(=0 ->» footwall fixed;
>0 => hanging wall fixed)

Total slip: 100

Display increment 5

O ramp up from decollement

” okay || [ cancel |

Technical note: The coordinate system used by the computer, and used internally by trishear, has (0, 0) in

the upper |eft corner of the screen with positive down and to the right (i.e., the way you read a book). If you examine
any of Trishear's data files (which are plain ASCII text), the numbers that you see are not those related to the axes
drawn on the screen but are the computer’ s internal coordinates. This makes computation and drawing to the screen

faster.
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es. (a) you can do “Modify” again and give it a larger
dip, or (b) you can choose “ Continug” rather than “Run”.
Choosing “Continue” tells the computer to run again
until it reaches twice the initial total slip. For example,
if your initial dlip was 75 units, the first time you choose
“Continue” after the first run, the model will run out to
150 units. The second time you choose “Continue” you
will get 225 units (three times the initial run) and so on.

7. You' ve completed your first trishear model, with afault
bend fold backlimb. If you turned off the display of
strain ellipses, you can turn them back on with “Show
Ellipses’ under the Plot Menu. To find out the details of
the strain, Choose “Get Ellipse Info” from the Model
Menu and click on an ellipse. The results will be displayed
on the screen or in a dialog box. Select the “History
Window” from the Windows Menu to see the changes
that you made. Then, bring the Cross-section Window
to the front again.

8. Save this model to disk by choosing “Save As...” from
the File Menu.

Complex forward model

The possibilities for making complex forward models are
limitless. In this example, we will assume that you have completed
the above example of a simple forward model and will add to it. If
the section is still on the screen you don't need to do anything;
otherwise start up the program (if necessary) and choose “ Open”
from the File Menu and select the file that you saved in step 8,
above.

1. Choose “New Fault” from the Model Menu. Unless you
have turned off “pick beds and fault with mouse” in the
Preferences dialog box, you will get the “Pick New
Fault with Mouse Dialog”. Leave all the parameters as
they are, but be sure that “ramp up from decollement is
checked”.

2. Click on the new tipline position of about (600, 0) and
drag up to the left to define a fault with a negative dip.
Make the ramp angle about —35° and the trishear angle
about 60°.

3. Choose “Run” from the Model Menu. The old fault
trajectory simply becomes a digitized surface and is de-
formed in the trishear field along with the beds. The
resulting geometry is complex but the section is com-
pletely area balanced.
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4. If you want, you can experiment with additional ramps
in this new fault (by choosing “Modify” from the Model
Menu), or you can add more new faults.

Normal fault with reverse reactivation

Erslev (1991) showed that trishear could equally well be
applied to normal faults. Such structures were called “extensional
forced folds’ by Withjack et al. (1990). To understand how exten-
sional trishear works, one must have a clear understanding of the
propagation-to-dlip ratio (P/S). P/S governs how quickly thetipline
propagates relative to the slip on the fault. In a thrust fault, the
tipline propagates towards the surface in the same direction as the
movement of the hanging wall. In the case of a normal fault, the
tipline propagates up towards the surface as the hanging wall moves
downward in the opposite direction from the tipline. In Trishear
4.5, the sign of P/Sis defined relative to the hanging wall; thus, for
reverse faults, P/S is positive but for normal faults it is negative.
Likewise, the slip is defined as positive if the hanging wall moves
up but negative if it moves down, as in the case of normal faults.
In this exercise, we will produce a simple trishear normal fault
with grown strata:

1. Choose “New” from the File Menu. For this exercise,
we will not enter the data with the mouse, so if you get
the “New Model with Mouse” dialog, click the Prefer-
ences button and uncheck “Pick beds and fault with
mouse”. When you get the “New Model” dialog, enter
the following values: ramp angle = 70; trishear angle =
70; Propagation/slip = —0.5; Total slip = -30; initia
coordinates of the tipline, X = 400, Y = 0; and bed tops
at 0, 30, 60, 90, 120. Click “Okay”

2. Lets move the model up so we can see it when the
hanging wall moves downward. From the Windows
Menu, select “Shift in Window...”. Leave delta X = 0
and set delta’Y = 200. When you click “Okay” the cross
section will shift upwards on the screen

3. Choose “Run” from the Model Menu. The hanging wall
will move downwards 30 units and a fold will form
over the upwardly propagating tipline.

4. Now select “Add Beds...” from the Model Menu. The
dialog box that appears will show you the highest points
the existing beds and will allow you to add a number of
new beds. In the blank space for Bed 6, enter 325 and
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click the “Okay” button. A new horizontal bed appears,
plotted in adifferent color (light blue or cyan by default).

. Select “Continue” from the Model Menu. The hanging

wall moves downward another 30 units and the new
bed top is folded.

. Select “Add Beds...” again enter 330 for Bed top 7.

Click “Okay” and choose “Continue” again from the
Model Menu. The hanging wall moves down another
30 units and the tipline begins to cut into the growth
strata. Add afinal horizontal bed to mark the base of
the post rift strata.

. Select “Show LNFES’ from the Plot Menu. Select “Get

Ellipse Info...” from the Model Menu and click on the
ellipse at (379, 2312 Note that one of the two lines of
no finite elongation in this ellipse has a negative dip.
This means that, if the line parallels a shear plane, then
that shear planeis areverse fault, even though the major
fault is a normal fault. See Withjack et al. (1990) and
Allmendinger (1998) for a discussion of this important
point.

. Finally, let’ sreactivate the fault as areverse fault. Select

“Modify” from the Model Menu and change the P/S to
1.2 and the Slip to 0. When you choose “Run”, this will
return the base of the model to a horizontal plane by
uplifting the hanging wall with respect to the footwall.
Note the folding in the upper layers even thought the
net dlip is zero.

Fault-bend fold the hard way

Although the programis called “Trishear” we can construct

true fault-bend folds. The example following this one shows you
the easy way to do this. Here, is a more complicated, but probably
more realistic way. The trick is to think about how mother nature
would make a fault bend fold: first make the fault trajectory with
very little slip and then slip over the pre-existing fault plane. The
way to make the entire fault trajectory is to specify a large
propagation-to-dlip ratio (P/S). We will also add growth strata in
this example to prove that the program produces fault-bend fold
kinematics as described by Suppe et al (1992)

© Richard W. Allmendinger 1998 — 2000
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1. Choose “New” from the File Menu. Set the ramp angle
to 30°, trishear angle to 60°, P/S = 150 (yes, that’ s right,
one hundred and fifty!), and slip =1.0. Click on the
Preferences button and change the dlip increment to 1.0
(by default it is set to 2 pixels). With these settings, the
fault tipline will propagate 150 pixels for each pixel of
dlip. Enter bed tops at 0, 30, 60, 90, 120, and 150.
Make sure that “ramp up from decollement is checked.

2. Select “Run” from the Model Menu. The fault plane
will propagate 150 pixels with almost no dlip.

3. Chose “Maodify...” from the Model Menu. Change the
ramp angle to 0. Then select “ Continue” from the Model
Menu until the tipline disappears off of the right side of
the screen. Y ou will seeavery dight uplift of the anticlinal
crest. Note that the two kink axes shown are active kink
axes related to the footwall ramp.

4. Now that we have made the fracture plane of the fault,
we can increase the slip to make the fold. Choose
“Modify...” from the Model Menu. Change the P/S to
1.0% and the Total Slip to 30. Choose “Run” from the
Model Menu.

5. You will see the fault-bend fold grow. When it stops,
choose “Add Beds...” from the Model Menu and enter
170for bed 7. Select “Modify...” from the Model Menu
and increase the total slip to 60". Choose “Run” from
the Model Menu.

6. Again, add a bed, this time at 190. Increase the total
dlip to 90 with “Modify...”, and choose “Run”. Repeat
this procedure as often as you like to build up the growth
Strata.

A few final words about fault-bend foldsin Trishear: The
program can only produce mode 1 fault-bend fold, not mode 2. A
perfect kink band fault-bend fold is produced in this example because
the tip line propagates so rapidly that there is essentially no time
for any deformation to occur in the trishear zone before the tip line
goes shooting past. An interesting scientific question to pursue is
just how low can P/S be and still produce what would appear to be

*Lowering the P/S to 1 is not really necessary; this example would work fine if it were left at 150.
However, by lowering the P/S we make it so that the fault tip doesn’t continue to propagate huge distances. Thisisa
convenience if you want to save a graphics file and don’t want to see avery long fault trajectory!

*This step is necessary because the initial slip was 1. |f we chose “Continue”, the total slip would be
changed to 30 + 1. We would have to choose “Continue” thirty times to get to atotal slip of 60!
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a (nearly) perfect kink fold. In our experimentation, a value of P/S
aslow as 15 produces a very respectabl e kink fault-bend fold.

Fault-bend fold the easy way

The previous example shows you how one had to do a
fault-bend fold in version 3.0 of Trishear. In version 4 and above,
there isamuch easier way:

1. Choose New from the File Menu. Set the bed tops to O,
30, 60, 90, 120, and 150; set the Slip to 30. Check the
two check boxes. “ramp up from decollement” and “ initial
multi-bend fault.” You can leave everything else at the
default values.

2. When you click Okay in the New Model dialog, another
dialog will appear telling you to draw the fault, beginning
with the down-dip-most point and clicking and dragging
to set each vertex (the vertex is set when the mouse
button is released). The mouse coordinates and the ramp
angle are shown. For this example, click the mouse at
(300, 0) and drag a ramp upward at 30° (or less) until
you reach a point midway between beds 3 and 4. Click
to set the vertex at the upper corner of the footwall
ramp and then drag out a horizontal flat until you reach
the edge of the beds. Double-click at the end of the flat
to set thetip line.

3. Choose Run from the model menu and a small fault-bend
fold will appear. Select Add Beds from the Model Menu
and add a bed about 5 units above the highest bed in the
current model. Choose Continue from the Model Menu
to run the model forward another 30 units of dlip.

4. Repeat step 3 several more times, each time adding a
new bed 5 units above the highest one in the model.
You will see a perfect set of fault-bend fold growth
triangles developing, just as described in Suppe et al.
(1992) and shown below (note that this graphic is a
simple screen capture bitmap and not the vector output
which one would use for a presentation or publication).

© Richard W. Allmendinger 1998 — 2000
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Listric Normal Fault

We can use the same “initial multi-bend fault” feature of

the last example to make alistric normal fault.

1. Choose New from the File Menu and enter the values as
shown in the screen shot, below. Note that, to make a
normal fault, both the propagation-to-slip ratio and the
slip must be negative numbers. Note aso that we have
checked “ramp up...” and “initial multi-bend fault.”

Mew Model

Fault/Trishear fone

Ramp Angle: 30,000

Trizhear angle: 4

¢

PropagationsSlip:

(=0 -7 foatwall fixed;
+0 - hanging wall fixed)

Total slip:

Display increment:

Ii

Initial coordinates of tipline:
%= (30000 | ¥= |0.00000 |

[ ramp up from decollement
[ initial multi=bend fault

[ Preferences... ]

Bed 1:

Bed 2:

Bed 3 :

Bed 4:

Bed 5:

Bed &:

Bed T:

Bed 8:

Bed 9:

Initial left (X} coord:

Beds
Tops Dip

|0.00000 | |0
|30.000 | |0
|60.000 | [0
|o0.000 | [0
[12000 | [0
| 150 0
| 180 0

[Pasitive dips are down ta left)
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2. Click on the Preferences button. We need to specify

how the hanging wall is folded over the listric fault.
Most people assume shear obligue to bedding or similar
folding, so click on the appropriate radio button. The
number to the right of the similar fold button is where
you specify the angle of simple shear, as an angle mea-
sured from the vertical. Leave this number set at 0.0,
which will produce vertical shear planes or the “ Chevron
method” roll-over of the hanging wall. Close the Prefer-
ences Dialog by clicking “Okay.”

. When you close the New Model Dialog, you will be

asked to draw the initial fault trace, finishing with a
double click on the tip line. If you have “Show Kink
Axes’ turned on in the Plot Menu, you will see a green
line drawn parallel to the shear plane direction (in this
case, vertical). After drawing the fault and before pro-
ducing any dlip, choose Modify from the Model Menu
and increase the ramp angle (which initially shows the
angle of the final fault segment) by about 5°. We do
this so that the fault will not propagate at the same
angle as the last segment drawn but at a steeper angle.
My initial fault trajectory looks like:

Backlimb Fold Kinematics:

() Parallel
@ Similar: Shear angle =

15

/

/

/

. Choose Run from the Model Menu. At the end of the

run, select “Add Beds” and add a single bed 5 units
above the highest bed. Then choose Modify from the
Model Menu and increase the ramp dip by about 5°.

. Repeat step 4 — except choosing “ Continue’ rather than

“Run” — several more times. A screen shot of the final
model is shown below, with lines of no finite elongation
shaded by strain magnitude. Except near the fault one

© Richard W. Allmendinger 1998 — 2000



Trishear User’s Manual 16
v. 45

of the two lines of no finite elongation always parallels
to oblique shear in the hanging wall. Note that the
model shows the well known roll over anticline, but it
also displays “normal drag” near the fault dueto tip line
propagation. Once the fault breaks the depositional sur-
face, no further “drag folding” (really tip line folding
occurs).

\\\_///
————5__ \ w

Inverse grid search

As the final example in this tutorial, we will explore the
inverse’ gird search modeling capabilities. This procedure takes
place in three parts. (1) Digitizing and resampling the deformed
section to be modeled; (2) a grid search to find the best fitting
trishear parameters that restore a key bed to an initial planar (really
linear, because we are operating in two dimensions) orientation;
and (3) making a forward model based on the best fit parameters.
As a general rule, the grid search can only be carried out on a
simple trishear monocline (either normal or reverse), which evolved
without variation in any of the key parameters.

°Geophysicists use the terms inverse model and inversion specifically to refer to the inversion of a matrix.
Our grid search isthus not an inversion by that definition. In the case of athrust fault like the Catskill example, what
wereally do is run alarge number of forward models, treating the thrust fault asif it were a normal fault unfolding a
deformed section. We use the term inverse model in aloose sense to refer to the fact that we are extracting the initial
undeformed geometry from the deformed geometry.
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Digitizing and re-sampling

Y ou can prepare a section for input to Trishear’ s grid search
routine in a number of ways as long as it is digitized as a text file
and follows a simple format (see details elsewhere in this manual).
| have found that a particularly convenient way is to scan a section
and read it into a graphics program. In the graphics program, you
simply trace over the beds that you want to import into Trishear
with the program’s polygon tool (not the Bezier curve tool)®. Then
save just your traced beds as a“ DXF’ (AutoCad) file. The starting
point for this tutorial example, isasample file called “Catskill.dxf”
which contains atracing of the structure presented in Allmendinger
(1998). We will first process this file with a small utility program
that is included in the Trishear package called DigBeds (short for
“Digitize Beds,” clever, huh?). DigBeds will read the DXF file,
extract the polygons automatically, resample them so they have
500 points evenly spaced along the length of the bed, and finally
save thefile in the format that Trishear needs for importing’.

1. Start up DigBeds. Close the About dialog box. Choose
“Open DXFfile...” from the File Menu. In the standard
file open/save dialog box, select the DXF file from which
you want to extract the polygons. For this exercise we
are using the file “Catskill.dxf”, which is included in
the Trishear package.

2. After you select thefile, adialog box will appear asking
if you want to shift the section on the screen. Enter
H(orizontal) = 150 and V (ertical) = 50 to shift the section
down and to the left. After you click “Okay” you will
see the repositioned section with the beds numbered

3. Next you will see a dialog box asking you if there are
any pairs of polygons which represent the same bed on
either side of afault. In this example there are two such
pairs. Polygons 1 and 2 are the same bed and polygons
3 and 4 are adifferent bed. Enter “1” and “2” in the two
text boxes located on the first line and enter “3” and “4”
in the two text boxes located on the first line. When you
click “Okay”, DigBeds will resample the beds, renumber

®There are a few simple, but important, guidelines for tracing the polygons in your graphics program. See
the details, starting on page 59 of this manual.

"In Trishear 4.5 and above, you can just scan the cross-section to be modeled, import the scan using Plot
Menu:Scan:Import Scan or Scan/Digitize Menu:Import Scan, and trace over the beds with the mouse in Trishear to
produce the digitized beds.
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them (if there were any broken polygons), and trace
over the original polygons in red to show you the res-
ampling and renumbering.

4. Choose*“Savein Trishear Format...” from the File Menu,
and you will get a standard file save dialog box to use
the name the file (call it “Catskill.dig” for this exercise)
and store it wherever you want on disk. Thisis the file
that you will read into Trishear. Quit DigBeds.

Grid search to find the best model

Now that we have digitized the beds of the structure and
converted them to a readable format, it is time to fire up Trishear
(if it isn't aready running) and import the model into the program.
To understand the grid search inversion fully, it is best to read
Allmendinger (1998) and Allmendinger et al. (in press?). An ex-
tremely brief overview is provided here: Basically, there are six
parameters that define a ssimple trishear geometry: (1) trishear angle,
(2), PIS, (3) fault displacement, (4) fault ramp angle, and (5) the X
and (6) Y positions of the fault tipline The grid search systematically
varies each of these parameters over a pre-specified range, testing
all unique combinations of these parameters. The criteria for good-
ness of fitis, ssimply, how well any particular combination of values
returns a key bed to an original linear orientation, using a least
squareslinear regression and c? as a statistic (the specific algorithm
used is from Press et al., 1986). The combination with the lowest
c® is the “winner”. Trishear can save up to a four dimensional
matrix of statistical values as atext file that can be read into various
plotting programs for visualization. This isimportant because the
program will report to you only the very best model for the key
bed, but there may be many other combinations that are nearly as
good for the key bed and produce a better overall fit to all of the
beds in the structure. Okay, end of overview, let’s see how it works
on the Catskill file (the numbering, below, follows from the previous
section):

5. Once Trishear is running, select “Import” from the Re-
store Menu or “Open” from the File Menu. Select the
file that you saved in step 4 (“Catskill.dig”) from the
standard File Open dialog box. Y ou are given the choice
of scaling the deformed cross-section so that it fits the
screen or maintaining the original dimensions (as scaled
by DigBeds, if you used that program). Click on “Origina
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Dimensions.” Once you do this, the deformed section is
drawn to the screen, as below, and several additional
menu items become available under the Restore Menu.

HM'_

6. Select “Automate...” from the Restore Menu. A large,
complicated and somewhat imposing dialog box appears.
Each of the options is explained more fully, starting on
page 42 of this manual. For this example, we will use
bed top 3 as the key bed. The ramp angle is know from
field data, so enter 36 in the box for minimum ramp
angle and |leave the other two boxes for ramp angle
(max and step) blank® For P/S, enter min = 2.4, max =
2.8, and step = 0.1, indicating that we will test five
valuesof PIS(i.e, 2.4, 25, 2.6, 2.7, and 2.8). For trishear
angle, enter min = 30, max = 40, and step = 1. Leave
the displacement settings just as they are. There are
many options for searching for the tipline, which can
easily be the most time consuming part of agrid search.
At this point, just enter TiplineX min =421 and Tipline
Y min = 146, with the step size blank, indicating a
single tipline position very close to faulted bed top 2.
Thefault isareverse fault, so make sure that the “Reverse”
radio button is enabled. When you are ready to click
“Okay”, the dialog box should look like the following
screen shot:

®*Thisis the standard way of specifying a known value: always enter it in the “min” field and leave the other
two fields blank. If you enter something in the “max” field but no step size, then only the min will be used.
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Enter the number of the key bed
which you want to restore using
a planar bestfit

Key Bed #:

(between 1 & 6)

Automate Restoration>="————H
min. max. step
Ramp angle: |3ﬁ | | | | |
P/S ratio: [24  |[28 ][ |
Trishear angle: [30.000 |[40 | [1 |
|

Save Statistics:
[ 2-D slices of 3-D matrix (kb)
[ Column text of 3-D matrix (kb)

[ best model applied to all beds

Displacement:  |0.00000] [-1000.0] [2.0000
[ always search to max displacement

Tipline X: |:|
Tipline ¥: [ ] [ ]

[J use mouse to select tip region

Fault type to restore:

in aregion on aline
Preferences... Q g ®

[(cancer J|[_ ok | @ Reverse ) Normal

7. When you click “Okay”, Trishear goesto work. A dialog

box or text on the screen will indicate the number of
models being tested, the current best model and an esti-
mate of the amount of time remaining (which is wildly
inaccurate at the beginning of a grid search run). With
the above settings, it will say that 55 models are being
tested, yet each one of those models will have 500 dis-
placement steps. Thus, in the span of a minute or less,
your computer will have tested 27,500 unique combina-
tions of the six trishear parameters.

. When Trishear isfinished it will show you the restoration

of all the beds (see following diagram), based on the
best fit parameters for the key bed. Open the History
window from the Windows Menu and you will see the
grid of tested values as well as the statistics for the key
bed. If you want to see the statistics for all beds, choose
“Show Statistics’ from the Restore Menu.

. To watch a real time restoration of all the beds using

the best fit parameters for the key bed, select “Set Pa-
rameters...” from the Restore Menu. You will see the
best fit values filled into the text boxes. Make sure that
none of the check boxes are checked. Click the Okay
button. You will see the initial deformed cross section.
Choose “Restore Beds” from the Restore Menu and the
section will be progressively retrodeformed before your
very eyes, stopping at the best fit slip. If you want to
back up to check out something, choose “ Unrestore Beds”
from the Restore Menu to deform the section again.
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Forward Modeling of Restored section

There are several reasons why you would want to forward
model your best fit restoration. One reason would simply be to see
how well the idealized geometry matches the real deformed geome-
try. Also, strain and particle paths can be calculated only from a
forward model. Asthefinal step in our example of thegrid search,

10.

11.

12.

13.

Choose “New...” from the File Menu. A dialog box
appears asking if you want to model the deformed beds.
Click “Yes'.

Do not change anything in the New Model dialog box
which then appears. You may wish to click the Prefer-
ences... button to make sure that calculation of strain
ellipsesisturned on. Close the New Model dialog box
by clicking the Okay button. Y ou will see an idealized
starting bed geometry appear.

Choose Run from the Model Menu. The forward model
will run until it reaches the best fit total slip. You can
click the (left) mouse button at any time to stop the run
before it reaches the final slip. Once stopped, you can
do anything else you want such as modify the parameters,
etc.

To compare the forward model to the initial deformed
section, you will have to return to your graphics program
and paste the forward model over the original section,
rescaling as necessary. At the present time, it is not
possible to compare the two within Trishear. Once a
forward model is run, the deformed section is no longer
in memory. If you want to try another restoration of the
same section, you will have to import it again.
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Forward model of Catskill structure overlaid on original tracing (in green) in a graphics program.

A few final words about inverse modeling...

The amount of time that the grid search can take depends
on the number of parameters and the ranges that you search over.
If you can constrain three of the see parameters, as in the Catskill
example where the ramp angle and tipline position is known, the
grid search should take no more than a few tens of minutes at most
(depending on the speed of your computer, of course). However, if
you search over even moderately broad ranges of all six parameters,
it can take many hours or even many days of computing time. In
general, it is best to use relatively restricted searches with large
step sizesfirst and then fine tune as you zero in on an answer.

Tests that we have run where we carried out inverse modeling
on forward models generated with known trishear parameters shows
that the grid search is very accurate at finding the correct answer
(Allmendinger et al., in press). However, you may well be disap-
pointed with the results of the inversion when you apply it to your
own real data. Wasn't this supposed to make our lives easier by
letting the computer do the work? The answer lies in the probability
that most real sections had variations in trishear parameters during
their formation while the inverse method assumes no variation during
deformation. Ramp angles may change, P/S may vary as the tipline
encounters different lithologies, and so on. Thus, | use the grid
search to get an general idea of the basic range of appropriate
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parameters, and then fine tune my fit to the real structure by forward
modeling. Needless to say, this “fine tuning” generally takes con-
siderably longer than the grid searching!

Menu Reference

Here, we provide aitem by item description of each option
available in each menu and in each dialog box in the Trishear
program.

File Menu

The File Menu handles most (but not all—see the section |Gy edit_model

New... %N v ;i

on the Restore Menu, below) input and output of dataand graphics | open. | savePistas (it %6 |
files, aswell as printing and quitting or exiting. Note that you can I

Save » Save Strain as (text)...
set the default parameters for the program by choosing Save Prefer- SRS w
. Page Setup... AutoCAD DXF
ences under the Edit Menu. If no preferences have been saved, | print. #p [T
Quit #Q

you will have to choose “New...” before you can plot anything.

New...—Commonly, your first step once you have fired up @ Fle Edt Modsl Res
the program will be to choose “New...”, particularly if you want to oo
do a forward model. The following dialog box will appear, with Close
the program’s built in default values. The dialog box is reasonably g
. Save strain as...
self-explanatory, except for the following: Export DXF...
« TheDisplay Increment controls how frequently the screen itt

updates during a model run. If you set the value to “1”
the screen will be updated at each step of the model,
producing essentially an animation of the model. If
your computer is fast, this can be instructive. Model
runs, however, go faster if the program does not have to
draw to the screen every step. The default valueis*“5”,
meaning update the screen every five steps. Note that
this setting has no effect on the model run, itself.
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Model data
New Model——————~H — Fault/Trishear Zohe
Fault/Trishear Zone Beds
T Di
Bed 1 I]l]‘I']ll']T]I] 0 P Ramp angle: Im
Ramp Angle: 30.000 ed 1= - [~ E0.00000
fed 2 20000 p Trishear angle: E0.00000
- B .| — |
Trishear angle: 60.000 Propagation/Slp | 1.500000
Bed 3: | 60.000 0
Propagation#5lip: . [Oif Footwall fired:
(=01 -5 f N Bed 4: | 00.000 0 >0 then hanging wall]
=0 == footwall fixed;
>0 => hanging wall fixed) Bed 5: 120.00 0 _—
Total zlip: 100.0000
Total slip: 100.00 Bed 6: -
Display increment:
Display increment: |5 Bed 7:
Initial coordinates of tipline: Bed 8: Initial coordinates of tipline:
X = [300.00 Y= |0.00000 Bed 9:
| | v | | ¢ K=| E | 0.00000
Bed 10:
u T'a_rr_lp i fr':_'m (e e W 1amp up from decallerment
O initial multi-bend fault E=IMIE I~ Iritial multibend Fault
Bed 12:
_ (Positive dips are down to left) ml
C 1
” Okay, “ (_cancet Initial left {¥) coord: (50 oK I Cancel |

— Bed
Tops Dips

Bed1: | 0.00000 0.00000
Bed 2 30,0000 0.00000
Bed 3 £0.0000 0.00000
Bed 4: 30,0000 0.00000
Bed5: 120,000 0.00000

BedE:
Bed 7
Bed 8
Bed 5

Bed 10:

Bed 11:

Bed12:

[Fazitive dips are down to left]

Initial left (%] coord: I 50

If you want a normal fault, you must enter a negative
value as your initial Total Slip setting. If you want the
tipline to propagate upwards in the stratigraphic section
during normal fault movement, you must also enter a
negative value for the Propagation/Slip setting. Other-
wise the tipline propagates in the same direction as the
movement of the hanging wall.

Strain ellipses can only be turned on at the beginning of
a model run, not in the middle. This is accomplished
by clicking Preferences and then checking the Strain
ellipses check box. When you show ellipses, every
fifth ellipse is plotted in a different color, making it
easier to track them through the deformation.

Faults and beds are inclined down to the left if they
have a positive dip and down to the right if they have a
negative dip.

Y ou enter bed tops and their initial dipsin the columns
on theright. A starting model can have a maximum of
twelve (12) beds. However, atotal of twenty beds can
be analyzed using the “Add Beds’ menu command under
the Model Menu (see below). Thus, you can have 12
pre-growth beds and up to 8 growth beds or, for example,
five pre-growth beds and up to 15 growth beds. Beds
entered in this dialog box can have any initia dip but
beds which you enter later are dways flat, unless entered
with amouse.

The length of the beds is controlled in the Preferences
dialog box. Each bed can have up to 1000 vertices and
you can adjust the spacing between points on a bed.

If you choose “Pick beds & fault with mouse” in the
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Preferences Dialog (see the Edit Menu section, below),
you will instead get the dialog box to the right called
“Pick a New Model with Mouse”. After you set these
parameters, you will see a series of short dialog messages
on screen instruction you on how to select the beds.
Beds which are picked with the mouse can be flat or
dipping. Y ou can also specify whether the left edge of a
bed occurs at the given x-coordinate, or wherever you
first click the mouse (by selecting the check box). You
set the fault with the mouse by clicking and dragging.
The first mouse click sets the position of thetip line and
then the drag sets the fault ramp angle. You candragin
either direction to set the fault angle, but it is the first
click that sets the tip position. A click without a drag
will give spurious results. After the ramp and tipline
are set, afinal click and drag sets the trishear angle.

Whichever way you enter a new model, if you have
checked “initial multi-bend fault” you will have to
draw the fault tragjectory on the screen with the mouse.
Any given ramp dip isignored. When entering an initial
multi-bend fault, thetip lineisdrawn |ast and isidentified
by a double mouse click.

When you run a new model or start a new fault (Model
Menu), you can specify with a check-box in the "New"
dialog box whether the starting tipline position of the
fault represents an initial ramp up from decollement
or whether the faults continues to project downward
from the tip line with the same ramp angle specified in
the New dialog box (i.e., the "normal" behavior in ver-
sions prior to Trishear 2.5). Having a ramp up from a
decollement produces a trailing fault-bend fold syncline,
with the forelimb of the fold a trishear fault-propagation
fold. The ramp up from the decollement is modeled as
a kink-style fault-bend fold or a similar fault-bend fold,
depending on which option is selected in the Preferences
dialog box. This option enables one to model trishear
detachment folds.

Old...—You can read back into the program any model, at

any stage of development, that you have saved using the Save As
menu command. A standard Macintosh or Windows “Open File”
dialog box will appear, alowing you to select the file that you
want. Note that any ASCII text file will appear in this dialog box,
but only flies which match the exact format of the file produced
using Save As will be read in successfully.

Close—The close command will hide the front-most window

but otherwise has no effect. Y ou can show the window again by
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Bedding
Humber of Beds: l:l
Initial left (X} coord:
O left edge at mouse click

Fault
Propagation/Slip:

(=0 -> footwall fixed;
00 -» hanging wall fixed)

Total slip: 100
Display increment: 5

[ ramp up from decollement
[ initial multi-hend fault

Preferences...
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choosing it from the “Window Menu”.

Save Model As (text)...—This command gives you a standard
Macintosh save file dialog box which will alow you to save the
exact configuration of the model currently on the screen in the
Cross Section Window. This model can be read back into the
program using the Old... menu command.

Save Model As (PICT)...—The current cross section in the
“Cross Section window” can be saved as aMacintosh PICT file or
a Windows BMP file for input into any graphics program. The
PICT file creator ID will be set to Canvas 5, but any graphics
program can read this file. The separate vector objects are all
editable as such in the graphics program. The BMPfileis a generic
Windows bitmap.

Save History As (text)—At any time, you can save up to the
last 250 lines of the history of changes of your modeling session as
a text file with this command. This is particularly useful in the
Macintosh version because the History Window of the Mac version
is not scrollable and can only display the final 45 lines of the
history of the model. To see older steps, you must save the History
buffer to disk. In Windows, the History window is scrollable.

Save Strain As (text)...—T0 save a text file of the strain
values of each of the ellipses in the current model, select this
command. The data for a single ellipse occurs on a single line in
the text file and is as follows: X coordinate of the center of the
ellipse, Y coordinate of the center of the ellipse, the maximum
principal stretch, the angle of the maximum principal stretch axis.
Each of these four values is separated by a space, not a tab. Note
that the X and Y coordinates in the file correspond to the coordinate
axes shown on the screen, not the internal coordinate system. This
file can be read into a plotting program and contoured for striking
graphical presentations

Export as EPS...—EPSfiles are ASCII text files which can
be used to send high resolution graphics data to Postscript printers
or can be read by Postscript compatible graphics programs such as
[llustrator, Freehand, and Canvas. The advantage of an EPS file
over a PICT file is that the former has much higher resolution,
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allowing you to get rid of the “jaggies’ in your graphics. Thanks
go to Stuart Hardy for convincing me to implement this! EPS
export is available only on the Macintosh.

Export as DXF...—DXF files are atext file format devel oped
by the makers of AutoCad. Like EPSfiles, they enable high resolution
printing when imported into a graphics program. As implemented
in Trishear, they are more flexible than EPS files because they
include text whereas Trishear EPS files do not. | recommend using
DXF export over EPS export in general. DXF export is available
on both Windows and Macintosh versions.

Print—Standard dial ogs to send the contents of the front-most
window to whatever printer you have selected. Macintosh files are
printed asPICTs, Windows as bitmaps.

Quit or_Exit—Does what it says... You are asked whether
or not you want to save anything first.

Edit Menu

Undo—Y ou can undo the most recent operation by choosing —
Ii!"! ode estore

undo. This not only returns the graphic to the previous state but T %z Edituisde' Bestore
also resets the model parameters to the previous state. Undo uses a cut p— Firdo
temporary scratch file written to your hard disk during operation of e o I
the program; this file will be deleted automatically. If you switch e e

out of the program while it is still running, or if the program S e T T—
crashes, you will see these temporary files on your disk. These R e SEREED

files are standard Trishear output files, so in the event that you do
suffer a crash (heaven forbid!), you can recoup your section be
reading the old scratch file back into Trishear the next time you
gtart up. On the Macintosh, it islabeled * FOR00000000". Particularly
in the Windows version of the program, you may notice a slight
delay at the beginning of an operation while Trishear writes the
scratch file to disk.

Redo—Y ou can redo the most recent operation by choosing
this command. Redo also writes a separate scratch file to your hard
disk. On the Macintosh, it islabeled “FOR00000001".
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Select Text—Copying text is atwo step process in the Win-
dows version of Trishear. First, you select the items to be copied,
then you choose copy. “Select Text” works only in the History
Window of the Windows version. First, bring the History Window
to the front, then choose this menu item, then drag across the text
that you want with the left mouse button down, finally, choose
Copy from the Edit Menu.

Select Graphics—Copying graphicsis a two step processin
the Windows version of Trishear. First, you select the items to be
copied, then you choose copy. “Select Graphics’ works only in the
Cross Section Window of the Windows version. First, bring the
Cross Section window to the front, choose this menu item, and
then drag across the graphics that you want holding down the left
mouse button. Note that a selection rectangle will not appear. Finaly,
choose Copy from the Edit Menu.

Select All—Use Select All in either window to select the
entire contents of the window for copying. Then, choose Copy
from the Edit Menu. This command is available only in the Windows
version of Trishear.

Copy—In the Macintosh version, Selecting Copy will auto-
matically copy the entire contents of the front-most window to the
operating system Clipboard, for immediate importing into other
applications. The information is copied as a PICT file and retains
itsfull vector and text editing capabilities in the receiving application.
Copy in the Windows version is enabled only after you have chosen
Select Graphics, Select Text, or Select All. Text copied thisway is
fully editable; graphics are copied as bitmaps and can be modified
as bitmaps in painting programs. Graphics do not retain their vector
information.

Clear—This command will erase the contents of the front-
most window. It only affects the currently displayed graphics or
text. It does not change the model in any way.

Preferences...—The Preferences dialog, shown below, al-
lows you to set many of the advanced features in Trishear. Note
that several of these options will cause the program to run more
slowly if checked. However, the slowest part of the program exe-
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cution is drawing the graphics to the screen. If, for example, you
want to calculate strain ellipses, you can select them in Preferences
(they are turned on by default), but turn off the plotting of strain
ellipses in the Plot Menu, and you will notice little slow down.
You will be able to turn on plotting of strain ellipses at any time
using the Plot menu. The following explains each of the itemsin
the Preferences Dialog:

Length of beds, Spacing btwn points on bed—Each
bed in Trishear can have a maximum of 1000 vertices,
so the maximum length of the bed is a function of the
spacing between the vertices. If you use a two pixel
spacing, you can enter any length up to 2000 pixels. If
you enter a length of 1000 (with a two pixel spacing)
then Trishear will have to process only 500 vertices per
bed and the program will run more rapidly. Note that
the spacing between points on a bed does not have to be
an integer; you can enter, for example, “1.5”. Thereisa
trade off between spacing of points and resolution: in
general closer spacing will result in smoother curves
but will take a longer time to calculate. If you set a
combination that would need more than 1000 vertices,
the program will automatically adjust the bed length to
the nearest possible value. This may be a somewhat
confusing way to set the bed length but it is more flexible
and efficient.

Slip Increment—This item controls the increments of
the amount of slip on the fault that occur between pro-
cessing steps. As set in the above picture, the computer
will recalculate the trishear displacement field every two
pixels of dip. Because trishear is a continuous deforma-
tion, the smaller the dlip increment, the more accurate
the resulting section, but the long the processing time
needed to accrue any particular amount of dlip. For for-
ward models, 2 pixelsis a reasonable value; for inverse
modeling of forward models, however, we found it nec-
essary to use slip increments as low as 0.25. Note that
the smallest total dlip that can be used is equal to the
dlip increment. Thus, in the fault-bend fold example in
the tutorial (page 11), the slip increment had to be set a
1 to get the tipline to propagate 150 pixels at a P/Sratio
of 150; had we left the slip increment at 2, the tipline
would have propagated 300 pixels.

Center concentration factor—Zehnder & Allmend-
inger (2000) showed that a large number of potential
velocity fields satisfy the trishear boundary conditions.
The value entered here determines how strongly the de-
formation is concentrated towards the center of the tris-
hear zone. A value of “1” yields the linear trishear of all
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previous authors. Increasing the value produces a nar-
rower and narrower shear zone in the center of the trian-
gular zone, as shown below where “c” is the center
concentration factor:

 Asymmetric Trishear..—Zehnder & Allmendinger
(2000) a'so showed that trishear zones do not have to be
symmetric with respect to the fault to preserve area.
With this option in the Preferences dia og, you can specify
how much of the trishear zone is in the hanging wall
and how much isin the footwall.

symmetric trishear where, the trishear zone is 25% in the hanging wall (left), 50% in the hanging wall
middle, symmetric trishear), and 75% in the hanging wall (right). In all three, the dashed line shows the pro-
ection of the fault plane into the trishear zone.

* Pick beds and fault with mouse— if checked, this box
allows you to draw the beds and fault(s) on the screen.
The following menu commands behave differently if
Pick with Mouse is turned on: File:New, Model:Add
Beds, Model:Start New Fault. Although you can set the
tops and dips of beds, and the tipline position, ramp
angle and trishear angle of faults with the mouse, you
will still need to enter the number of beds, left coordinate,
P/S ratio, displacement, etc. in adialog box. However,
in the case of Add Beds, if Pick with mouse is turned
on, you will not see a dialog at all, the cursor will
simply change to a cross to allow you to click and drag
to add a new bed.
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Clip growth strata at surface—By default, growth strata
(layers that are added after the start of a model run) are
truncated where they run into any older strata which are
higher than them. This option can be toggled on and off
with this check box in preferences.

growth strata “clipped” at pre-growth surface

31

Backlimb fold kinematics—With these two radio but-
tons you set the fold kinematic model that is used to
construct folds over changes in fault dip. If Parallel is
selected, then the program will attempt to use parallel
kink folds over bends in the fault. Note, however, that
the program does not follow the Medwedeff & Suppe
(1997) multibend kink fold geometry. Therefore, parallel
folding with multi-bend faults can result in local zones
of non-parallel (but still balanced) folding and lack of
balance can result if the kink axes cross within the strati-
graphic section.

Select the “Similar” radio button if you want arbitrarily-
inclined shear oblique to the layers as the kinematic
model. In this case, the program will use the constant
heave method to construct the folds while preserving
cross-sectional area. With this option you must specify
the shear angle, which is defined as the deviation from
vertical of the shear planes, as shown in the figure,
below. In the figure, al initial fault trajectories were the
same, as was the slip in from the left. The only thing
that variesis the fold kinematic style.
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Asyou can see in the figure, above, the constant heave
method commonly resultsin slip increasing up-dip with
synthetic shear and listric faults. The constant heave
construction shown below shows why this occurs:

slip
shear

constant heave

slip

shear

constant heave _.—="

/

e Calculate strain ellipses—This checkbox must be se-
lected before, or during the setting up a new model.
Once a model has been set up (by clicking Okay in a
new model dialog), clicking this option will have no
effect until you next choose new model. Checking “Cal-
culate strain ellipses” will automatically check “Show
Ellipses’ in the Plot Menu. Calculate strain ellipses is
selected by default (unless you save preferences with
thisitem turned off)
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High resolution strain ellipses—Normally, ellipses are
drawn as polygons with 15 vertices, however, if you
want better quality (with the overhead of more processing
time) you can click the “High resolution strain ellipses’
check box, and then ellipses will be drawn with 24
vertices.

Dense array of strain ellipses—Normally, ellipses are
just drawn centered between bed tops. At times you
may want strain to be calculated on a denser gird for
contouring of strain magnitude, for example. Clicking
this box will draw ellipse along each bed top as well as
in-between each top, effectively doubling the number of
ellipses (and increasing processing and screen redraw).

Calculate particle paths—Particle paths do have to be
turned on in this dialog box before they can be plotted.
Clicking “Plot particle path” will automatically check
“Show Particle paths’ in the Plot Menu. However, you
can turn off the plotting of particle paths while still
calculating them in the background.

Allow Background processing—this allows you to do
other things with your computer (but not within the
trishear program) while you are running an inverse model.
This will cause your Macintosh to run more slowly be-
cause each time through an inner loop it will check the
System to see if there are any events pending. The Win-
dows version of Trishear does not have this option be-
cause the inversion and several other operations always
run in a separate thread from the main program.

Robust linear fit—enables the statistical calculation of
the same name as described in the book Numerical Rec-
ipes. It will markedly slow down your inversionsand is
not necessary in the vast majority of inverse models.

Save Animation Frames—If you select "Save Anima-
tion Frames" checkbox, every single step of the subse-
guent analysis will be saved to a folder as a series of
numbered PICT files. [This option is not yet available
in the Windows version of Trishear.] The program will
keep saving animation frames until you turn it off by
un-checking "Save Animation Frames' in Preferences
(if you forget, you can fill up your hard disk rapidiy!!!).
This means, though, that you can add beds, modify faults,
and start new faults all during a single animation. Y ou
can only start to save animations at the start of a new
model run. You will be asked only once to provide a
root name (e.g., "my animation") and a folder to store
the animations in and then the program will save all
frames there prefaced by numbers so they sort correctly
(e.g., "001my animation", "002my animation", etc.). Do
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not preface the root name with a number; if you do you
will get files named something like "001001my anima-
tion"!

With the correct software, you can turn these into an-
imated GIFs, QuickTime movies, etc. for smoother an-
imation than is possible within the Trishear program,
itself. Animated GIFs can, for example, be posted to
Web pages for viewing without any additional software.
QuickTime movies can also be viewed within web pages
using the QuickTime plug-in. | useYves Piguet's freely
available "GifBuilder 0.5" to make animated GIFs, which
can then be viewed either in a web browser or in any of
the available QuickTime movie players.

Save Prefs...—This command will automatically save the
current state of the Trishear program to disk in the same fold/directory
as the program itself. Every time Trishear starts up it looks for this
information in afile caled TrishearPPC Prefs or Trishear_Prefs.txt.
If this file is found, the program uses these settings rather than its
own built-in defaults. Note that the current state of bedding, too, is
saved in thisfile. If you choose Save Prefs with a deformed section
on the screen, you will get the same deformed section every time
you start up the program! The only way to go back to the built-in
defaults is to delete the prefs file manually. The Macintosh version
will save another prefs file at the same time called TrishearPPC
colors. Thisfile contains any colors that you have set with the “ Set
Colors” submenu under the Plot Menu.

Reset to Default—Choosing this menu item will erase what-
ever model you on the screen and will reset the program to its
default values as defined either by a preferences file or, if aprefs
file cannot be found, by internal defaults.

Model Menu

Much of the manipulation of your model takes place with
the commands in the “Model” menu. Here is where you actually
start the model run, but also where you can “change horses in
mid-stream” so to speak by changing parameters in the middie of a
model run.

Run—After you have entered a model with New... or OId...
you actually start the model run using the Run menu command.
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The model will run until it has reached the slip that you have
specified, either in the New Model or the Modify model dialog
boxes. If you want to stop the model before it has reached that
amount of dlip, just click the (left) mouse button. You can then
resume the model run using either Run or Continue.

Continue—This command works just like Run, except for
thefollowing: If your model has reached the amount of dip specified,
Run will have no effect; you would have to open the Modify dialog
box to increase the dlip before Run would make the model keep
going. Continue, however, will automatically increase the total
slip setting by an amount equal to the first slip entered. Thus, if
you enter 30 as the dlip in the New dialog, when the model reaches
30 it will stop. If you then choose Continue, it will automatically
resume until it reachesadip of 60, when it will again stop. Choosing
Continue athird time will run the model out to a dlip of 90, etc., all
without having to bring up adialog box. Thisis particularly useful
for inputting growth strata as additional beds at regular intervals.

Modify...—This Dialog box (left) contains much of the power
of Trishear. You can change any of the parameters shown at the
right. Note that a single model run can have up to 100 different
ramp angles A change in ramp angle produces a fault-bend fold
whose kinematics is determined by the setting in the Preferences
dialog. A second ramp which is steeper than the first will produce
atrailing syncline whereas a gentler ramp will produce an anticline.
If “Parallel” is selected in Preferences, Trishear attempts to follow
Suppe’s (1983) rules for fault-bend folds so that bedding thickness
remains constant across the kink (plotted as a green line) related to
the change in dip. This is always possible for fault-bend fold
synclines, but not always so for anticlines. Trishear will warn you
if you specify an “illegal” ramp (for the case of anticlinal bends)
but will let you go ahead and enter it. If you have ellipses turned
on, you can see the non-volume constant deformation that this
produces!

Although you can enter alarge number of rampsin Trishear,
there are some aspects which you should take into account. Trishear
tries to follow Suppe’s (1983) fault-bend fold rules but multiple
ramps can get pretty tricky and the program will warn you below,
the first time you enter a third ramp (below, left). The program
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does not attempt to follow in detail the kinematics described by Warning: Any beds that lie above the
Medwedeff & Suppe (1995). First, any part of a section that lies | intersections of two kink axes will not plot

above the intersection of two kink axes will not be area balanced | mayresult,butthe section will still be area

- halancad

In the example to the right, below, the two top beds are not balanced o
in the triangular region above the intersection of the two green
kink axes. Second, because of the simple velocity description that
we use for movement over ramps, the program does not generate
all of the subsidiary axial surfaces described by Medwedeff &
Suppe (1995). Where there are more than two ramps, the section
below the intersection of the kink axes will be area balanced but
may locally have zones of similar foldingrather than paralel folding
You can identify these zones of similar folding by choosing to d
show lines of no finite elongation (LNFE). Parallel folding occurs
where one of the two sets of LNFE is parallel to bedding; similar  gxample of a case where the kink
folding is the implicit kinematics wherever neither of the two sets axes do not function properly in
of LNFEs parallel the bedding. The following diagram illustrates '"'shear.

just such a case:

~20% thickening due to similar
folding (note LNFEs oblique to
bedding). Section is still area
balanced, however. If it weren't
area balanced, the program
would not draw the LNFE in the
ellipse

Ot
Parallel folding and no /%
thickness change (one of

the two sets of LNFE are
parallel to bedding) %ﬁﬁﬁ%— strain in footwall due to

Trishear deformation

e v e ide et ali it Ae e
4
Add New Bed Tops B
Cross sections can have up to 20 beds. & new dialog box
will appear after you hawve added the 12th bed.
Bed 2: E::- Bed 8:
Add Beds—This command will get you a dialog box in s, o, %
which you can enter new beds. The highest points on the existing | ., S
beds are shown in editable fields, but this is a cruel hoax—you || ,.q. Bttt
can't! The first blank box is conveniently selected for you to add beas: [ ] etz
the next bed. AIthpugh normally you will Want this bed to be v ot o s ot
higher up, you can in fact enter a next bed within (or below!) the |[tetsereshoun for our reference.
. . . . . ’ ay
existing section, in case you want to model sills, for example. All '
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beds entered after the initial ones (i.e., all “growth strata’) are
plotted with the Cyan color so that you can distinguish them easily
on the screen. Like the New model dialog, the add beds dialog
initially shows only 12 beds. However, once you enter the twelfth
bed, the next time you call up Add Beds... you will get a slightly
modified dialog box that will allow you to add up to 20 beds, total.
All beds entered in this dialog box start out flat. If you want to add
new dipping beds, first go to Preferences and choose “Pick beds &
fault with mouse’.

Get Ellipse Info—If you have turned on “ Calculate Strain”
in the Preferences dial og, then this menu option becomes available.
After selecting this, you can click on any €ellipse in your plot and
the ellipse parameters — orientations and magnitudes of the principal
axes, orientations of the lines of no finite elongations (LNFE) —
are displayed for you. If the array of points defining the ellipse
cannot be satisfactorily fitted to an ideal geometric ellipse, you will
get the message that you see to the right. Such ellipses will not
have LNFE plotted in them, nor shading by strain magnitude.

Get Particle Path Info—If you have turned on particle paths
in the Preferences dial og, then this menu option becomes available.
After selecting this, you can click on any particle path in your plot
and the length and average orientation of the particle path are
displayed for you.

Show Bed Numbers—This will temporarily label each bed
on the screen according to the bed number that Trishear uses to
identify it. These numbers are not saved with the plot.

Renumber or Delete Beds..—At any point in a model run,
you can tell the program to change the numbering order of the beds
or even delete a bed entirely. To change the number of a bed, enter
its current number in the “Old bed number” box and type the new
number that you want the bed to have in the “New bed number”
box. Both number have to be less than or equal to the total number
of beds in a model. To delete a bed, enter its number in the “Old
bed number” box and check the “Delete” check box. Any number
entered in “New bed number” is ignored. The program will not
warn you that you are about to remove a bed. Note that deleting a
bed does not remove any strain ellipses associated with that bed.
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Either deleting or renumbering will cause other beds in the model
to be renumbered also.

Get Bed Info—This command brings up a dialog box con-
taining a variety of information about whatever bed number you
type into the bed number text box. The “Area beneath bed” is the
area between the bed top that you enter in the dialog box and the
next lowest bed number, in the case of the dialog box to the right,
it would be the area between bed tops 3 and 2. If bed 1 is your
lowest bed and you enter it in this dialog, the area will be that
between bed 1 and the next higher bed. This command works with
both forward models and deformed sections. Y ou can get confusing
results if your beds are not labeled sequentially with depth (e.g.,
bed top 3 lies between tops 1 and 2) You can change the bed
number while the box is open to get information about more than
one bed. In the Windows version of Trishear, you must first enter
the Bed Number and then click the “Calculate” button to see the
information. For information on another bed, just click the ap-
propriate button.

Area btwn 2 Beds—You can have Trishear calculate the
area between any two beds in your section. Trishear will show
label al of the beds on the screen and then ask you for the two
numbers. The area is displayed in the same dialog box. The area
calculated is of a polygon where in the ends of each of the bedsis
connected to the other bed. Trishear will check to make sure that
the polygon vertices are ordered in the same direction (in the case
of forward models, the vertex number always increases from left to
right). For deformed sections, vertices are numbered in whatever
order they were traced in your graphics program. This command
works with both forward models and deformed sections. The program
measures area very accurately, but... Where a bed is offset by a
fault, the program simply assumes that a straight line connects the
hanging wall and footwall cutoffs. If there is a change in ramp
angle between those two cutoffs, then the area calculation will be
incorrect. In those cases, you would be better off using “Measure
Ared’, below.

Measure Area—BY selecting “Measure Area”, you can use
the mouse to trace out any area you want on the screen. To trace
the area, you draw a polygon much like you would in any graphics
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program. Click on successive points until you have defined the
area that you want, then double click to finish. (Note: a double
click in this case is defined by whether or not the mouse has
moved more than one pixel from its previous position; it is not
defined by the speed with which you click.) The traced area is
shown with a red line. Your polygon should have less than 500
vertices. Once traced, a dialog box like that shown above will
appear with information about the area traced and the cumulative
length of the sides of the polygon. Trishear will always close the
polygon for you even if you do not return to the first vertex to
double click (thus showing you the area measured). The length
reported, however, isjust that of the actual polygon that you traced
out. If your polygon was open, you will get the length of just the
sides drawn.

Area ofthe traced polygon = 17208.

Length of polygon = 722.55

39

—

Start New Fault—The menu selection under the Model Menu
called “Start New Fault” allows you to stop movement on the
existing fault and begin to deform the already deformed stratigraphic
package, as well as the old fault, by movement on a new fault
located wherever you specify. The dialog box for starting a new
fault depends on whether or not you have selected “Pick with beds
and fault with mouse” in Preferences; both are shown. Even if you
choose to pick the fault with the mouse, you will still have to enter
P/S, total dlip, and display increment by typing. You can choose
whether the fault ramps up from a decollement or not, etc. Aswith
the initial fault, your new fault can dip either to the left (positive

© Richard W. Allmendinger 1998 — 2000

Start New Fault 8

A section can have up to 34 inactive
faults and 1 active fault

Ramp Angle: 30.000

Trishear angle: 60.000

Propagation/Slip:

(=0 -> footwall fixed;
0 - > hanging wall fixed)

Total slip: 10

=

Display increment: 5

Initial coordinates of tipline:

x=[300.00 | ¥=[0.00000 |

O ramp up from decollement
[ initial multi-bend fault

Preferences...

H Okay ]l [ Cancel ]




Trishear User’s Manual
v. 45

dip) or down to the right (negative dip). The new fault can subse-
guently be modified with the Modify command under the Model
Menu. Note that the deformation in the hanging wall of the new
fault is with vectors parallel to the new fault trace. If you fold an
older ramp over a new ramp, everything will be sheared parallel to
the new fault, producing bedding thickness changes in the beds
above the old ramp. Any section can have a maximum of five
inactive and one active fault.

Rotate Model...—With this command, you can produce a
global rotation of the model, including the beds, fault(s), trishear
zone, ellipses, etc. (but not the axes themselves). Y ou can specify
the axis of rotation either at the tip line or by clicking the mouse on
the screen. Using this command one could, for example, ssimulate a
rotating domino fault, etc..

Restore Menu

Y ou use the Restore Menu when you want to analyze de-
formed strata which you have digitized (using some other program).
Once you have read in the beds using the Import Beds... command,
you can then set the parameters for your restoration. The whole
reason for this restoration module is that, when you are trying to
model real structures, it is often easier to evaluate the goodness of
fit of a particular set of parameters by seeing how well they unfold
the beds to an initial more or less planar state. Forward modeling
is much more time consuming even though both are by trial and
error.

Import Beds...—With Import Beds... you will be presented
with a standard Macintosh or Windows open file dialog box to
select the file containing the deformed beds that you have digitized.
The file is an ASCII text file but the format must be followed
exactly. Hereispart of atypical file (in Courier font) with comments:

Note that the internal coordinate system of the program is
the same as that of the Mac or Windows screen: X positive to the
right and Y positive downward with the local origin at the top left
corner of the window. This is the coordinate system that Trishear
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expects digitized beds to be in. When you read in a deformed bed
datafile, it will automatically be resized to fit to the screen. | tend
to digitize beds by scanning them, tracing over them in a graphics
program such as Canvas, and then saving the resulting polygons
(not Bezier curves!!) inaDXF file. | have written autility program,
“DigBeds’, which massages and resamples DXF files for reading
into Trishear. See the end of this manual for brief instructions on
the use of DigBeds. You can do it however you want as long as it
fits the above format.

When Trishear imports the beds, it gives you two choices,
as shown in the dialog box, at left. You can either scale the beds to
the screen or maintain the original dimensions (the default). Note
that scaling to the screen will not increase the accuracy of the
inversion and may result in longer inversion runs if the original
graphic was smaller than the screen.

Set Parameters...—Y OU choose restoration parameters with
the dialog box, below. Y ou can enter al of the necessary parameters
by typing numbers into the left side of the dialog box. However, it
is often easier to use the mouse to enter some, or most of the
parameters (the P/S ratio must be typed in, of course). To use the
mouse, you select from the check boxes at the right, but there are
several ways that you can do this. The most general way is with
the top check box: After selecting this, you first click the mouse
that the position of the tipline and then (without releasing the button)
drag the mouse to define the hanging wall boundary of the trishear
zone. Then click and drag the mouse again to define the footwall
boundary (the program will automatically connect your second line
segment to the tipline you chose with the first click). When you do
this, you also automatically define the ramp angle because it must
be the bisector of the trishear zone you have just defined.

If you know the ramp angle already then you would type it
in on the left and then use one or both of the check boxes in the
middle part of the right side of the dialog box. If both are checked
then you first click (and let go of) the mouse at the position of the
tipline. A small black dot will be drawn where you clicked. Then
you click and drag the mouse to define a trishear zone which is
symmetric about the ramp which you typed in at the left. If you
leave either of the boxes unchecked, then the text value at the left

© Richard W. Allmendinger 1998 — 2000

41



Trishear User’s Manual
v. 45

will be used for that parameter. Note that checking the top box
will automatically uncheck the two boxes in the middle, and vice
versa. Finally, tell the program whether you are restoring a reverse
fault or anormal fault with the “radio” buttonsin the lower right.

Set Restoration Parameters =c———H
5Set Restoration Parameters
Fault dip {ramp} = [ setramp, TS angle,
& tipline with mouse . )
Trishear angle = Fault dip [rarmp):
use mouse for angle .
Propagation/slip = o g Trishear angle: I 60,0000
use mouse for tipline . .
Tipline Coordinates o g PropagationdS lip: I 1.50000
X =1-30 Y= | 668 .
Fault type to restore: Tatal Slip: I 0.0a00a
Total Slip: D @ Reverse (r Normal (leave blark ta wn untl mouse click]
{leave blank to run until mouse click)
[ cancet | [ ok ||

Tipline Coordinates

l_ uze Mouse

" Fault type to restore;

i+ Reverse

y [ coon

far tiplire

" Momal

Cancel |

o]

Restore Beds—Choose this to begin the restoration. The
program displays every single step of the restoration on the screen
(the Display Increment parameter has no effect). The only way to
stop a restoration is to click the mouse — just let it go until the
beds become planar or it becomes apparent that they are not going
to become planar and then click. If you then want to forward
model the restored beds, just choose New... from the File Menu.
The tipline position, bed tops (actually the highest points on the
restored beds), and dlip will be entered in the New dialog as the
default values! [Don’'t say | never did anything for you!! :-) |

If you don’'t like your restoration, just choose Set Parame-
ters... again. You will see the above dialog box again and can
change any or al of the values (either with text entry or the mouse.
As soon as you dismiss the dialog, your original starting digitized
deformed beds will be displayed again in the same position (unless
you have re-scaled or shifted the plot; see below), ready to be
retrodeformed again with the new parameters.

Unrestore Beds—If you overshoot your desired restoration,
you can “back up” the model by choosing Unrestore. This behaves
exactly like Restore but in reverse.

Automate...—You can perform a full inverse model by
searching over the six-parameter grid of values which define any
simple trishear restoration. This grid search isinitiated by calling
up the Automate Restoration dialog box. The grid search is performed
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just on one key bed, which is specified in the upper left corner of
the dialog box; it can be any bed that you choose, but normally
would be the bed for which you have the best constraints. When
you choose Automate, the program automatically displays the num-
bers of each bed on the screen for reference. The inversion attempts
to find the best combination of parameters with returns the key bed
to astraight (but not necessarily flat) line. We do this by calculating
aleast squares best fit and minimizing ¢ (chi-squared) as described
in Numerical Recipes, whose algorithm we have used. We also
calculate the correlation coefficient, R (Pearson’s R), which is in-
versely related to chi-squared. Note that the best fit for the key bed
probably will not be the best fit for all of the other beds.

=——————— automatoRestaration———— 5| LCUCIISUEIT
Enter the number of the key bed min. max. step Enter the number _of the key bed wic_:h ya
which you want to restore usinga [T 17 17 1 want to restare using a planar best fit
planar best fit namp angie- | Su.uun || |
r . .
P75 ratio: 1.5000 ||3 0.1 : |3
| — |
Key Bed *: |3 | ! ! ! ! ! | keyBed #:
. Trishear anale: E | Tan I T4 |
{between 1 & 63 ¢ 22 e i i etz i)
Displacement: iﬁ_ﬁﬁﬁﬁﬁl i_iﬁﬁﬁ_ﬁi iz G000 i ~Save Statistics
Save Statistics: [ always search to max displacement ™ 2D slices of 30 matrix for key bed
1 2-D siices of 3-D matrix (kb . v | ™ Colurnn test of -0 matrix
ClColumntextof3-Dmatrix{kh) |~ = = 1Ll I~ bestmodel applied to all beds
L —— 1—— 1% |
_ Tipiine ¥: | 668 I |
] best model appiied to all beds _
[ use mouse to select tip region — Fault type to restore
{rin aregion @ on a line & Reverze © Momal
| Preferences... |
Canltdumn +tn mnctnen
Fault type to restore
; (7 S
|__Cancel ]| oK | @ Reverse (2 Normal Cancel | oK. I
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mir, MaK. step
Fiamp angle: I 36 I I

P/3 ratio: |1 500000 |3 |_1

Trishear angle: |3U I?U |2

Dizplacement; IU— IW
™ ahways zearch to may displacement

Tipline x: I 350,00 I —

Tipline " I 0.00000 I I

¥ uze mouse to select p region

" in a region & on aline

The grid of values to search is specified in the right hand
side of the dialog; there are six parameters which completely define
any trishear model: (1) the ramp angle; (2) the P/S ratio; (3) the
trishear apical angle; (4) the displacement (or dip); and (5 & 6) the
X and Y positions of the tip line. In general, for each of these
parameters, you specify a minimum value, a maximum value and
the step size. For example, if for ramp angle you entered min = 30,
max = 50, and a step of 5, the program would test values of 30, 35,
40, 45, and 50 degrees. If you only enter a minimum value (leaving
max and step blank, not zero!), the program will test models using
asingle value for that particular parameter. Thiswould be the case
if, for example, you could measure the real ramp angle in an outcrop
or on seismic. Constraining a parameter to a single value vastly
reduces the number of models your computer will test.
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For displacement, you do not enter a step size because the
that is built into the program (it is fixed at the Slip Increment
specified in the Preferences dialog). Likewise, all restorations actu-
aly start at zero displacement, regardless of what you enter into
the min box. The number in the min displacement box, just deter-
mines the displacement step at which the program starts to calculate
the statistics for the bed. If you know that all reasonable models
will have well over 100 units of displacement, you can save yourself
some run time by skipping the statistical calculations for the first
part of each model run. Asadefault, the program finds a minimum
value for c?in aleast squares fit to a straight line through the key
bed array. Then, to make sure that it is not a local minimum, it
searches another 100 displacement units beyond this best model.
If it doesn’t find a smaller ¢, then the program iterates to the next
set of model parameters. This can speed up your model run consid-
erably, but it does have some danger because it does not truly
search the entire parameter space, leaving open the possibility that
some smaller value of ¢ (i.e., a better model) has been missed.
You can override this behavior of the program and force it to
always search out to the maximum displacement you have entered
by checking the “ always search to max displacement” check box.
A maximum displacement is necessary because some models never
converge on a minimum c? if you leave the max displacement
blank, the program will automatically truncate any run at 2000
displacement units. Because all cross sections are scaled to the
screen before beginning, 2000 displacement units is far more than
you should need. Note that, if you enter a displacement larger than
2000 (e.g., 4000), the program will search out to that larger value.
The sign on the displacement is, in fact, meaningless because the
“direction of restoration” is actually controlled by the “Reverse’
and “Normal” radio buttons as the bottom right of the dialog; these
work identically to the buttons of the same name in the “Set param-
eters’ dialog.

Y ou can choose to type in values for the X and Y positions
of the tipline, but it is commonly easier to check the box below and
use the mouse to identify the region in which you want to search
for the best tip line positions. Y ou have two options for using the
mouse: (1) you can search for the tip within a rectangular region
(“inaregion” radio button) or (2) you can search “on alin€e’, i.e,

© Richard W. Allmendinger 1998 — 2000

44



Trishear User’s Manual
v. 45

the projection of the fault. This second option is particularly useful,
of course if you know where the fault is but don’t know exactly
where it terminates within abed. It allows you to limit the number
of tipline positions quite markedly with respect to the “In aregion”
option. After the dialog box is dismissed, if you have chosen “in a
region” you drag the mouse on the screen to specify the rectangul ar
region in which you want to search for the best tip line. If you have
chosen “on a line” you first drag the mouse to define the fault
plane, and then you drag the mouse again to indicate where along
the trace of the fault you want to search for the tip line. Even if
you use the mouse, you must enter a value for the tipline step in the
appropriate place in the dialog (one step value for both X and Y).
Note that searching for the best position of the tipline can easily be
the most time consuming part of the modeling process:. if you drag
the mouse across a 200 by 200 pixel area and indicate a 1 pixel
step size, the program will search 20¢ (i.e., 40,000) models, and
this assumes no variation in any of the other four parameters! On
my PowerBook 3400, searching 40,000 models takes five to ten
hours! Search large areas with a coarse tipline grid. During an
inversion, Trishear will keep you informed of the total number of
models being tested, as well as how many have been tested so far.
The total time will be reported at the end of the run but is not saved
as part of the cross section.

If you have selected “allowing background processing” in
preferences, or if you are using the Windows version, you can
switch out of Trishear start up other programs, surf the web, etc..
Trishear will continue testing models in the background, albeit
more slowly. You can speed up a model run by turning off back-
ground processing but will only gain about 5 to 10% in execution
time (unless you are doing something really processor intensive
likeray tracing...) and will not be able to use your Mac for anything
else

The statistics from a grid search can be saved in a variety of
ASCII text formats. The checkbox, “3-D matrix for key bed” will
work only if the ramp angle and the tip line are constant and the
only variation is in the trishear angle and in P/S. Then a suite of
fileswill be saved, one file for each P/S step, with each file containing
trishear angle vs. displacement, with contours of <*. the “Column
text of 3-D matrix” check will save a single large file of a 4-
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dimensional matrix (the c¢* values at every unique combination of
ramp angle, trishear angle, P/S, and displacement). Thisfile consists
of five columns, one for each of the dimensions and the final one
for ¢®. consequently, the file is very large, generally more than 1
Mb in size. However, data in this format can be read into IDL or
Noesys or other visualization programs for plotting in 3-D. The
“Best model applied to all beds’ check box will save an ASCII text
file of the 2-D matrix with displacement on the vertical axis, bed
number on the horizontal axis, and contours of chi-squared. Y ou
can read this file into your favorite graphing program as “space-
delimited text” for plotting.

When an inversion begins, the program will display asmall
dialog box (Macintosh version) or will write on the screen in the
Windows version, showing the progress, including the estimated
time remaining (which will actually increase early on in the inver-
sion). In the Mac version, you can click on the “Stop” button to
terminate the inversion. The current best model will be displayed
on the screen. Alternatively, if you click suspend and save, you
will be presented with a standard save file dialog with which you
can name a file to contain the interim results. In the Windows
version of Trishear, if you simply click anywhere in the screen
area while the inversion is going along, a dialog box will pop up
asking if you want to Stop, Suspend and Save, or Continue. You
would press “Continue” if you clicked in the window by accident.
Like on the Mac, in the Windows version if you click “Suspend
and Save”’ you will see a save file box to specify the file to save the
interim results in. The current best model is written to the screen
and you can then shut down your computer if you want.

Resume Inversion—If you have previously saved interim
results from an inversion, you can resume that inversion at any
time. First, though, you must import the beds using the Import
command under the Restore Menu. Then you select, “Resume
Inversion”; you will be presented with a second dialog box where
you can select the file in which you saved the interim results in the
first place. Then, theinversion will proceed as before.

Show statistics—At any stage of an analysis, you can write
the linear least squares best fit statistics for each bed to the History
Window with this command.
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Plot Menu

The Plot Menu controls several aspects of drawing
on the screen but none of its options influence the models
themselves. Basically, you use the top part of the plot
menu to turn on or off the plotting of various graphic ele-
ments. For example, forward models will run much faster
if the program doesn’t have to take time drawing strain
ellipses to the screen at each step of a model run, even if
the strain at each step is being calculated in the background.
The choices, Show Ellipses, Show LNFEs, and Show Principal

{01 Windows Help

~ Show Beds
+ Show Trishear Zone
Show Kinks

[
#1

Show Ellipses
Show LNFEs

Show Principal Axes
Show Particle Paths

%0

Shade LNFE by Strain

Shade Ellipses by Strain %9

Digitized Beds
Scan

4
4

Set Colors
Load Colors...
Save Colors...

4
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@ Scan/Digitize  'wWindows
v Show Trishear Zone
Show Kink Axes
Show Elipzes
Show LFNE=
Show Principal Azes
v Show Particle Paths

Shade Ellipses by Strain
Shade LMFE s by Strain

Set Colors
Save Colors
Load Colors

Axes are available only if you have selected “ Calculate
strain ellipses’ in the Preferences Dialog. Likewise, Show
Particle Paths is available only after you’ ve turned on the calculation
of particle paths in Preferences. In all cases, a check mark appears
in the menu if the program is set to plot the particular element.

Shade Ellipses by Strain—In addition to showing the outlines
of the ellipses, you can color or shade them according to their
strain magnitude. The darker and more intense the color, the larger
the magnitude of the maximum principal stretch. This option allows
you to see very quickly where the zones of high strain are in your
model. You can shade ellipses without showing the ellipses; then
you will see the color fill but not the red or blue outline. Also
ellipse outlines are drawn everywhere, even if they are undeformed
circles whereas shading is only used where there is a stretch greater
than 1.

Shade LNFEs by Strain—The same range of colors can be
used to shade the LNFEs, giving an immediate impression of where
the strain is high, even if ellipses are not shown. If you choose,
Shade LNFEs, then Show LNFEs will be turned off automatically,
and vice versa

Set Colors— Y 0ou can assign whatever color your computer
is capable of drawing to any of nine different types of features that
Trishear draws. When you chose any of the options under Set
Colors you will see the standard Macintosh Color Picker dialog
box, as shown below.
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(I Choose a new fault color .
= Original:
1zo* &0

CHYE Picker g

Crayon Picker

Hue Angle: EI"
Saturation: %
. = ' - : Value: %
HSY Picker - I S0 100

HLS Picker

In the Windows version, you are presented with the following
dialog box. In it, you select from the drop list at the top the graphic
element whose color you want to change, and then click on the
radio button next to the new color that you want for that element.
When you click “OK”, the screen will be redrawn with the new
color.

Pick a Color x|

Pick a color for the IEEn:IS-F'regmwth

« | c |
T - m -
c M -’
Cmm - m

Cancel |

Load Colors— If you have saved a set of custom colors to
disk with Save Colors (below), you can load them back in with
Load Colors.
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Save Colors— At any time, you can save a set of custom
colorsto disk with Save Colors. These colors can be read back into
the program with “Load Colors.”

Set Line Weights...—This command will give you the fol-
lowing dialog box. Just enter a number (integers only!) next to the
feature whose line weight you want to change. As illustrated, this
can be particularly useful if you are trying to trace over a seismic
line. Single pixel width lines can be difficult to see when plotted
on top of a seismic line, but become much more visible when
given a heavier line weight (and changed to, say, yellow, as shown
below).

" NN SuE

[ o ' [ N Y|

Set Line Weights =icc0—"—=H
In the boxes below, specify the line weight in pixels that )
you want for each graphic element in the program. o
Integers only! —
£
Beds—pregrowth: I:I Kink axes: I:I '*f;
-
Beds—growth: I:I Ellipses: I:I E
&
Beds—Digitized: I:I LNFE: I:I =
]
Fault—active: Principal axes: I:I %
Faults—old: Particle paths: D
Trishear bndry: |:| Plot axes: D
[ Cancel ] H 0K ]l

Scan/Digitize Windows H

L . e Show Digitized Beds

Plot Menu:Digitized Beds, Plot Menu:Scan, Scan/Digitize Menu DR
Scale Digitized Beds

i ) DigitizediForward

Show Digitized Beds—This option allows you to turn on or Forward>Dighized

. e . . . Diraw Beds
off the plotting of digitized beds (see the discussion of difference Clear Digiized Beds

between digitized beds and forward model beds starting on page Dot San..

v Show Scan

4) . Drag Scan

Clear Scan...

‘ Shade LNHE by Mrain ||||.|||||i||||:||||

Drag Digitized Beds—Once you select this menu Digitized Be Show Digitized Beds %1
option, you can drag the digitized beds around on the Scan e Do e

b4

Scale Digitized Beds...

Set Colors 4
screen relative to the forward model beds. Only the dig- Load colors-- Aok

Set Line Weights... Forward =» Digitized

itized beds are moved. This is convenient to see how Forward =
ear Digitized Beds

well your forward model fits the original deformed geom-

Save Digitized Bed...

etry.
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Scale Digitized Beds—Use this selection to rescale the dig-
itized beds. The following dialog box will appear. Note that you
enter the scale factor as a percent of origina size, with 100% equal
to no size change.

O

m

Scale Deformed Beds

Enter the percent amount by which you
want to scale the digitized beds (use a
value larger than 100 to enlarge and less

than 100 to shrink).

the beds.

|
|
|
|
- - scale factor = %
Scale factor: |ﬂ z | I:I
: |
|
|
|

Cancel i | Ok 1 |

Draw Bed—Y ou can now draw new digitized beds within
the Trishear program. Combined with the various “ Scan” features,
above, this allows you to digitize a section completely within Tris-
hear, without using the DigBeds utility program. To start, select
Draw Bed from the Digitize Beds submenu. The cursor will change
to a cross with the current coordinates displayed next to it. If you
wait long enough (about four seconds) before starting the bed, the
dialog box to the right will appear with instructions. The bed is
drawn as a polygon, clicking the mouse button to defined the vertices.
The points are set when you release the mouse button, not when
you press it down. If you want your bed to have agap in it, press
the Shift Key at any time between the two vertices on either side of
the gap or use the right mouse button key on the first point on the
other side of the gap. When you are done, double click the mouse
(i.e., click twice without moving the mouse). The polygon that you
have defined will be resasmpled to have 500 evenly spaced points
init. You can draw up to 20 beds this way.

Use the mouse to define the bed polygon.
Polvgons can have up to 500 vertices. Press the
Shift Key while drawing a segment across a gap.

Double click to finish the polvgon. @

Draw a polygon...

Usze the mouze to define the bed polpgon.  Polpgons can have up to 500 vertices. Press
the RIGHT mouse button while drawing a segment across a gap. Double click to finish
the polygon.

o]

Once you have drawn the beds, it is the same as if you
imported digitized beds in the Restore Menu. You can drag them
around the screen, rescale them, convert them to a forward model,
etc. If you have a complex initial stratigraphy (e.g., with lots of
internal unconformities, etc.) that you want to forward model, you
can now draw those layers on the screen, convert them to aforward
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model with “Digitized->Forward” and run the model. Note, however,
that forward model beds that are made this way will not have any
strain ellipses associated with them.

Digitized—>Forward—Y ou can load the digitized bed infor-
mation into the forward model bed arrays by choosing this command.
You might want to do this if you have a starting bed geometry
which is too complicated to enter using the standard new model
dialogs. After you select this option the digitized beds will be
redrawn in the forward model bed colors and the New Fault dialog
box (page 39)will appear asking you to specify the fault parameters
associated with this new forward model.

Forward —> Digitized—This menu option will place a copy
of the forward model beds into the digitized beds array, replacing
whatever was aready there. Y ou might use this option if you wanted
to compare two models with slightly different parameters or if you
want to carry out the grid search inversion on the current forward
model.

Clear Digitized Beds—Use this to erase the digitized beds
from the program memory. All menu options related to Digitized
beds will be disabled until you read in new ones with Import (under
the Restore Menu of both Mac and Windows versions) or Open in
the Mac version.

Save Digitized Bed...—To0 save digitized beds as an ASCII
text file on your hard disk, select this option.

Import Scan will open a standard file open dialog box from
which you can select any PICT or BMP file. The file can contain
vectorsor scanned raster images at any resolution and can be color,
gray scale, or black and white images. Different graphics programs
save bitmaps in PICT/BMP files in different ways, so you will
have to experiment with the best settings. If you want to import a
high resolution scan, the surest way isto expand it to 72 dpi in the
graphics program and then use the “scale scan” feature in Trishear
(see below) to reduce its dimensions and increase its dpi’s In the
Windows version, you must scale the BMPin your graphics program
before importing it into Trishear. In general, B& W bitmaps take
much less memory but do not render as nicely as gray scale scans.
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If you import avery large scan, Trishear may not have the memory
available to display it; in that case you should quit Trishear and
increase the memory partition. Trishear always plots the scan behind
all other graphic elementsin the program.

Show Scan—Y ou can show or hide the scan while leaving
it in memory. This can be useful if the scan obscures features in
your model, but you are not finished with it yet.

Drag Scan—This allows you to grab and drag the imported
PICT/BMP around screen while keeping everything else in the
program stationary. Thisis useful for positioning the scan relative
to your model.

Clear Scan—Y ou cannot import another scan into the pro-
gram until you clear the first one from memory with Clear Scan.

Scale Scan... alows you to adjust the dimensions of your
scan. If you check “keep current proportions’ (the default behavior)
you need only enter a single number and the other box will be
adjusted automatically. Setting horizontal and vertical scales inde-
pendently allows you to correct for horizontal or vertical exaggeration
in the original PICT file The Windows version does not yet allow
scaling of the BMP file within the program.

Windows Menu

The Windows Menu provides access to display of the two
windows in the program. The Cross Section Window is where all
plotting and restoration occurs. The History Window keeps a text
record of your model run. Either window can be saved to disk or
copied to the clipboard when it isin front and is the active window.

Cross Section—Brings the Cross Section Window to the
front and makesit active.

History—Brings the History Window to the front and makes
it active. The contents of the History Window can be saved as a
text file at any time by selecting the appropriate option under the
Save Submenu of the File Menu. The most recent model run is
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always added at the end of the window. In the Windows version
the History Window is a fully editable, scrollable text window so
that you can select things and cut and paste. The contents of the
window in the Macintosh version is a PICT so it is editable only
when you cut and paste it into a graphics program. In the Mac
version the History Window is not scrollable and only that last 45
or so lines of the model history are shown. When you save the
History to desk as a text file (under the File Menu), you will get
the entire history (or at least the last 250 lines of it).
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Add to History—TheTrishear program automatically records
major changes to the model in the History Window (e.g., a new
model, addition of a bed, change in ramp angle, etc..). But there
may be other times when you want to record that state of a model.
Choosing Add to History writes out the current state of the model
with the annotation “User added”.

Shift in Window...—brings up the dialog box, above, which
allows you to type in precise X and Y values for moving a plot
around on the screen. This change is applied to all parametersin
the program. When you use Shift in Window, the model is moved
relative to the coordinate system. Thus, all of the coordinates of
the individua pointsin the model will be changed.

Drag in Window—If you prefer to re-position your cross
section visually, use this menu option. Once selected, the program
will wait while you click and drag the mouse anywhere within the
Cross Section window. An outline of the deformed beds will
follow the mouse around until you release the button. Drag in
Window move both the coordinate system and the model; therefore
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the axes will move, but the coordinates of the individual points will
not change. Drag in Window function like scrolling the window by
dragging. Drag in Window is not available in the Windows version,
because the Windows version has scroll bars.

Resize to Fit—This option both re-scales your model to fit
and positions it in the center of the Cross Section Window. Asin
Shift in Window, all parameters are changed so that you can choose
thisin the middle of amodel run that wanders off the page to move
it back to the middle before continuing.

Set Scale... — You can change the scale and position of the
axes on the screen with this option. Selecting it brings up the
dialog to the right. Once you set a new scale, all of the bed tops,
slip magnitudes, and tip line positions are entered in the various
dialog boxes in that scale. On the screen, the area, slip and prop-
agation are reported at the scale and units that you specify. Note
that the program maintains everything internally in decimal pixel
coordinates; this option simply allows you to enter more realistic
cross sections directly. You can enter anything you want: e.g.,
57.3 pixels = 1542.5 meters. It used to be that every Macintosh
monitor had 72 pixels/inch and every PC 96 pixels/inch but, with
multi-scan monitors, the size of a pixel can vary depending on the
resolution specified in the monitors control panel. The choice of
meters or feet is largely cosmetic, controlling only the labeling on
the screen. Y ou can now also put the origin of the on screen axes
at any point on the screen by selecting “Set origin with mouse.”
The axes now cover the entire screen and are always visible anywhere
you drag to scroll an image (by choosing “Drag in Window” under
the Window Menu; as long as you drag along an axis, of course).
The color of the axes are now drawn by default in gray, rather than
black; you can select any color you want for the axes by using the
“Set Colors” submenu under the Plot Menu. Thus you can define a
more realistic coordinate system for cross sections of features below
sealevel, asin the graphic below:
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Using DigBeds

One of the most arduous tasks in this digital world is digitizing data in a particular format
so that a computer program can read it. In the case of Trishear, one must digitize a deformed
cross section in a certain way before the program will recognize it. Fortunately, this task is not
too difficult thanks to a small utility program that | have written called DigBeds, which is
available for both Windows and Macintosh. Note that much of the same functionality of DigBeds
isnow contained within Trishear 4.5, thanks to the latter’ s ability to import scanned graphics and
draw new digitized beds over the top. However, there are still reasons why you might want to
use DigBeds. Modern graphics programs like Corel Draw or Canvas are much more flexible than
Trishear in allowing you to change magnification. Because of this, one can do a much more
careful job of digitizing layers in those programs than in Trishear. It is aso much easier to erase,
edit, and change the order of individual polygonsin those programs.

Basic Steps

The basic procedure for getting a section into a format that
Trishear can read is the following:

1. Read the section into your favorite graphics program.
The section could initially be a cross section on paper
or a photograph that you have scanned, or it could already
bein digital format.

2. Trace the beds that you want to model in Trishear with
the polygon tool of the program (see the “ Guidelines...”
below). If you need to know the precise position of the
fault, you can digitize that, too. Just don’t base any grid
search inversions on it!

3. Export just the polygons that you traced as a “DXF’
file, acommon ASCII text file format originally devel-
oped by the makers of AutoCad.

4. Start up DigBeds and choose “Open...” from the File
Menu. Select the DXF file that you just saved from
your graphics program. The polygons are drawn to the
screen and numbered in the order in which they appear
inthe DXFfile.
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6. A didog box will appear, asking you if any of the polygons
represent the same bed which has been offset by a fault.
In this dialog, you can enter up to five pairs of beds.
This step is important because Trishear expects only
one polygon per bed and yet you don’t want to digitize
any points on the line segment of the polygon located
between the hanging wall and footwall cutoffs. In the
above section, polygons 1 and 2 are the same bed and
polygons 3 and 4 are the same bed. Note that the order
in which you specify the polygons in this dialog box is
important! If you had written 4 and 3, then the left end
of 3 would be connected to the right end of 4.

7. DigBedswill then resample the polygons so that there
are 500 equally spaced points for each bed. In the process
of connecting any beds across a fault,the beds may be
reordered so that what was the first bed in a section
may become a later (i.e., a higher number bed). See the
comments below for more details. DigBeds will also
re-draw the beds on the screen in red so that you can
see the new beds numbers and check to make sure that
any offset beds were connected correctly. In the example,
below, note that polygons 1 and 2 are now bed 1, and 3
and 4 are now bed 2.
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8. Select “Savein Trishear Format” from the File Menu in
order to save your section resampled and formatted so
that Trishear can read it.

Additional Options in DigBeds

Help

DigBedscan do several additional tasks for you by choosing Renumber beds.. %R
one or more of the options under the “ Operations Menu”. ‘ oo ot o

Renumber Beds...—The order in which beds are saved in
the DXF file is exactly as you drew them to begin with in your
graphics program, which may not be in stratigraphic order. Although
Trishear 4.5 can handle beds in any order, it is most convenient if
they are in stratigraphic order, particularly for the drawing of strain
ellipses. Thisoption in DigBeds 1.1 allows you to change the order
of the bedsin the graphicsfile.
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Shift Beds..—When DigBeds imports your DXF file, it
automatically positionsit in the upper left hand corner of the computer
screen. Use Shift Beds to change the position of the cross section
on the screen. Positive numbers move the section down and to the
right. “H” stands for horizontal and “V” for vertical.

Scale Beds..—The DXF format is quite high precision,
much higher than possible on a computer screen. Therefore you
can change the scale of your section without significantly affecting
the resolution of your section. In the Scale Beds dialog, enter the
amount in percent by which you want to scale your section. You
may wish to shift the beds on the screen after scaling them.

Guidelines for tracing sections in your favorite graphics program

1. Use the polygon tool, not the Bezier curve tool or the
freehand curvetool.

2. Use as few points as you need to represent accurately
the structure. DigBeds will fill in the rest (and save you
a lot of mouse clicks). Each polygon should have no
more than 500 vertices.

3. If abediscut by afault, do not connect it with aline
segment along the fault. Trace it as two separate polygons.

4. Digitize each bed in the same direction. If you start the
first bed on the left, start al beds on the left. Thisruleis
particularly important for beds which are offset by the
fault. The last point of the first polygon must be the
cutoff against the fault, and the first point of the second
polygon must be the cutoff of the same bed on the other
side of the fault. See the following diagram:
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? polygon 1

vertex number

5. The first bed that you trace, or the “lowest” polygon in
your stack of objects will be labeled polygon number 1
when you open the DXF file in DigBeds. the highest
polygon (i.e., the one that would cover al of the others
if they overlapped) will have the highest polygon number.
If you have beds offset across a fault, it is best to trace
them first (or use “Send to back” in your graphics pro-
gram) so that they are “behind” all the other beds. This
is because DigBedsresamples and renumbers offset poly-
gons first. One of the main reasons to be concerned
with bed numbering is because of the way that Trishear
constructsit’s strain ellipses: the ellipses are drawn half
way between consecutively numbered beds. If the con-
secutively numbered beds aren’t adjacent to each other,
the ellipses will still be drawn half way between, probably
overlapping other beds, ellipses, etc.. Remember, how-
ever, that you can renumber your beds within DigBeds
1.1

6. When you save your DXF file, if your graphics program

gives you the choice of saving polygons as lines or as
polylines choose polylines.
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